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Session One introduced the Health Care Record and terminology used in
HEALTHone™ .

In this session we will introduce you to one of our patients: John Test,
and learn the techniques and methods required to use HEALTHone™
and find your way around the program.

Starting The Program

Double click it to start HEALTHone ™
(HIEA T EIOTE]

U

HEALTHone ™ has a built in security system that requires the user to
identify themselves by name and password to gain access to the
program. This information is entered in the LOGIN window illustrated
opposite.
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W% Login M= B
Ham=
[icm
If your practice has more than one ﬁfimm
source click on the one you wish to
open. Sources |

DEMD ONE
Usually you would type your name in the ||PEMDTWD
Name bozx, for now just type John

Click on the Password box and type
your code. In our example type: 1111

Login I Cancz| ™ Advanzed

Note: HEALTHone™ is case sensitive when letters are used in a
password.

See the Specific Tasks subjects in the Practice Management Section to
find out how to change your password.

Click on the Login button.

If the Name and Password you entered were correct HEALTHone™
allows access and the Patient Selector Window appears next.
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1

Unsuccessful Login

If either the name or password you entered were incomrect the message Invalid
Login Name or Invalid Password (whichever is relevant) will appear. Correct
the error and click the Login Button again.

Note: After three unsuccessful login attempts HEALTHone™ will automatically
close and you will need to go back and repeat the Starting the Program
exercise on the previous page.

The Patient Selector Window

Selecting a particular patient Health Care Record (HCR) is easy in
HEALTHone™ . The Patient Selector Window has dynamic filters that
immediately reduce the patient list to only those that match the filter.

HEALTHone™ is initially configured to filter by Surname,

First Name, Date of Birth or any combination of these, however;
additional filters can be added if required (see Adding Additional
Columns later in this session)
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Sorting the Patient List

Each column of information in the patient selector can be used as the
basis for sorting the patient list. Clicking on a column name will cause
HEALTHone™ to sort on its content.

Each column can have one of three states — marked by an arrow or its
absence.

Not sorted | sumarme |
Sorted in ascending order [sumame A
Sorted in descending order [sumame ]
- HEALTHonre™ initially only allows sorting by one column at a time, however, you can
1 sort by multiple columns by clicking on the Configure icon at the bottom of the
patient selector window and selecting the Options tab. Now select the Sort on

several columns option by clicking on its radio button. Click Validate to close the
Configure Window.

1) Experiment by clicking on the Surname column heading

If initially unsorted the patient list now sorts into ascending surname
order

2) Repeat click on the Surname column heading

Patient list sorts into descending Surname order
3) Repeat click on the Surname column heading

Patient list returns to unsorted state.
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Adding Additional Columns

Adding Additional Columns

HEALTHone™ has a variety of information columns which can
be displayed in the patient selector window, such as patient

address, telephone number efc. It is also useful to see the S Poem
sumane

Cohnrs | Search option: | Dptiore |

patients GMS number. Additional columns are displayed by frst hamn=
adding them to the patient selector. L.
dale o birth
. . . addrzss of pafient
As soon as a column is added it can be used both as a filter localty of patient

postal code patient
telechone privale
name of spause

name of contact pereon
GMS nunber [ref.1]

(by typing in the box above the column name) and a means of
sorting the patient list.

Click on Cenfigure button at the bottom of the

family nurrber [rf

Patient Selector Window hrenead fet
fi 4 o

Click on the select box opposite the address of name of dsctar n charge
patientto place a in tick it. dactarin charge

department .
Do the same for the GMS number daie of fle oparing

dale o death [2]

Click on the Validate button to close the dele sion of resert o
ale of dizcharge [4]

Configure Window. palien ieferznca:

. . name of partrzr hd
+ Patient Selector window now has two |[«] | 3
additional columns

e e e 7= 9 3

« Yaidite X Lancel

Adjusting Column Widths

There should now be two additional columns of patient information —
however; these are not spaced correctly. Some columns are too wide for
the information they display and others are too narrow. The width of
each column can be altered by dragging the adjuster bar to the left of its
heading.
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Column Adjuster Bars Adjuster lcon

v

sumame | first name: [ ven dats of birth
YOUNG DOMAL

TEST AGED 3 male 25/02/96
L

ICoT [Ta1NTA] 11 mEnD

When you place the mouse cursor on an adjuster bar it will change shape fo the
“”" Adjuster Cursor. Now drag left to reduce the column width or right to increase it.

1) Experiment with adjusting column widths to achieve the approx.
appearance as illustrated below.

SLINAME | frat name. sex date of bi addiess of patiert GMS numier [ref. 1
2 14 L0WER MOLUNT STREET P

TEST BGED 3 mak  PRINZER HILL WIEW FF

TEST JOHH wmae 1100819 FORREST VIEW e

Icor oo L oncion s iuscomeT Anmarrae

Selecting an Existing Patient

1) If the Surname filter is not currently selected (insert cursor flashing)
click once in the white box above the column name.

Surname filter is now selected

2)Typea T

The list of patients reduces to display only those whose surname begins
with ‘T’

3) Typean e

The list of patients further reduces to display only those whose surname
begins with ‘Te’

Select John Test in the patient list.

Click on the Select button.

The Health Care Record (HCR) for John Test opens.
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et APPOINTMENTS
1 You may have noticed in fig. 2.1 the Appointments tab. This is where you
access the appointments module. See the Appointments chapter later in this

book to find out how to use it

The HEALTHone™ Screen

This is the HEALTHone™ screen when a patient's HCR is open. The
three panels mentioned in session one, problem, transaction and item,
can be clearly identified.

Major Areas of the Screen

HEALTHone™ Standard Toolbar ltem Panel Toolbar
Windows Title Bar

Billing Module Tab

HEALTHone™
Menu Bar . -
Analysis Toolbar Window
Confrols
Problem 4 HEALTH one 1.5 - DN TF°T - 11
Panel 4
esactien | girg | ,‘
T i /
o g psenen e OV 23HG TABLET s 1
& g pRsra on InviruﬂHFRmml MG TERIFT tahe 1 lahe1" Ay Ay
ek, 1000
Trneatinn I & diug prescipson: Im-umsdmsnmsl ORAL T5MG TABLET Iabs, 1 lajfs 1° fdey, 23
B%E !
Trananclie. | Resporsib | Moment of oeerence | ;
Health | |[T7crei b ot otz 5] HCR Window Controls
/ carssdl D Fory 0T 2175674 8 (Current Patient File)
Care i pr M mcrst D3A2A7 14
Record, iy ermdl D Py Ol 23002437 1454
Area i ool = Transaction Information Area
il ol Dr Moy DDn- 201207 1545 - - i
e oal o o1 Red text = Locked, Black = Editable
cerait D Py 01 12400433143 -
|9 cormil D Firy OD1i 220503871045 HEALTHane™ prompt !
cocad O Firy 001 20432083 Area Session
Fit IRER I .
et b o o 3130 4 Information Area
|96 cormil D Firy ODsi 0110503371021
cored! O Ry DD: 024W/33 A 33
e o Ay s 348
L 1
0400 |86 Yaars |Dwg prarcipion |Bervrl piactice |Dn Rew DDsccd
Fud cwversin [Tor ke Emith— HFRT ARF ﬁﬂ‘ﬂﬁ
Transaction Panel Item Panel
Lists Transactions in the HCR Displays Selected Transaction Detail

The HEALTHone™ Screen - Screen Panels
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The HCR screen is divided into three separate panels: Transaction, ltem
and Problem.

Each of these displays a specific part of the patient’s file (HCR) as
described below.

The Transaction Panel

The Transaction Panel is used to display each event that has been
recorded. A new transaction is added to the Health Care Record for any
reason not simply because a patient visited for a consultation, i.e. to
record an experts report, a lab result, a visit at home, an issue of a
repeat prescription etc. Transactions in this panel are divided into the
two chapters: Administrative and Medical.

We will look at quick ways to navigate through the various transactions in
this panel later, for now:

Tranzactions |

&%

Tranzactio... | Responzib...
o Administrative chapter
EY identific Dr. Rory O'Dri 28,0992 12:00
% Medical chapter
basic n Dr. Raore O'0ri 28/03,/32 12:00
ZE conzull Dr. Roy 0'Dri 28/09/92 12:00
ﬁ expert: Dr. Ray O'0ni 02/10/92 1200

kaoment of occurence

1) Using your mouse, click once to select any transaction in the
Transaction Panel. The transaction becomes blue when selected.

2) Now use the up arrow and down arrow cursor keys on the

keyboard to move from one transaction to another. The highlight moves
between transactions. Notice the information in the Item Panel changes
to reflect the contents of the current transaction.
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3) Now repeat press the up arrow until the Administrative Chapter
comes into view. You can now see that the Administrative
Chapter has just one transaction and the Medical Chapter

starts with the Basic Medical Information transaction.

The Item Panel

The Item Panel is used to display the contents of the selected
transaction. Each transaction can contain one or more items.
Remember the discussion on this in the Introduction section.

Note: By default when you open a patient’s record, the last
transaction displays. It is possible to set it to open automatically in
either the Administrative or Basic Medical Information transaction if
preferred. To do this click on the menu item « tools — options » and
choose from the drop down list «Open the HCR on».

The Problem Panel

The Problem Panel is used to display the patient’s principal active or
inactive medical

problems. This feature can also extend to linking the relevant
transactions to the condition

they relate too. We will show you how this is done later. It is possible to
hide this panel if

you are not using it:

Click on the View menu and select the option Problems
Problem panel disappears.

Click on the View menu and select the option Problems once again.
Problem panel re-appears.

The HEALTHone™ Screen - Using Menus
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HEALTHone™ menus act exactly like any other Windows application,
simply click, point, click.

HEALTH
m Edit View Analysis Tools Window Help
0] New d =23 - 11 B2
Er Y| & HCR Ctrl+0
= Save || Document
B Saveas Template  Shift+Ctrl+F2
Switch HCR Shift+F10

Receive (DXM) Ctrl+ Alt+D
Send (DXM)

Start DXM Ctrl+Alt+X
Export all HCR data

Synchronise with active source  Ctrl+Alt+Y

Synchronise configuration across network...

D AD & Mls B

Print setup
4| Print preview

£ Print

Switch source
Switch delegator
Delegate access rights

Exit Alt+F4

1) Click once on the File menu at the top of the screen
2) Move the mouse to point to Open

— Sub menu appears

3) Move the mouse to point to HCR
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4) Search for John Test then click on a patient to select.

The first transaction in John Test’'s HCR is selected in the
Transaction Panel and his administration information appears
in the Item Panel.

Menu States

Menus and their various options are dynamic in that they have two
states, active or inactive. A menu will become inactive, and therefore un-
selectable, if the task they perform is not relevant to what you are
currently doing.

Inactive menu options appear light grey in colour and active menu
options appear black.

In some instances the menu will not be present at all. The HCR menu,
for example, will not be present on the menu bar unless a patient's HCR
is open.
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File| Edit View Analysis Tools Window Help
#_-I HE'W »

@ Open 2

Switch HCR Shift+F10

Receive (DXM) Ctrl+ Alt+D
Send (DEM)

Start DXM Cirl+ Alt+ X
Export all HCR. data

- i i g

Synchronise with active source  Ctri+Alt+Y

Synchronise configuration across network..

S

=

Print setup
Print preview

Brint

Switch source
Switch delegator

Delegate access rights

Exit Alt+F4

Selecting a menu option

Short Cuts
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- Short Cuts
1 You may have noticed in fig. 2.3 the notation next to some of the

menu options. Ctrl+  means hold down the Control key and ~ + Ctil+End
keep it held down while pressing the key following it in the Cul+Pglp
notation. For example, o get to the beginning of the HCR the Ctl+PgDn
short cut is Ctrl+Home. This means keep the Control key held | Cyklp
down while pressing the Home key. In time you will remember ERED D

many of these and find them quicker to use than the menus.

The HEALTHone™ Screen - Toolbars

A toolbar is a strip of buttons and possibly other objects that achieve
various tasks i.e. open the Patient Selector Window; create a new patient
file etc. etc. The HEALTHone™ Window has two toolbars: Standard
and Analysis. If an icon is greyed out it is not relevant to the area that
you are currently using.

The Standard Toolbar The Analysis Toolbar
A A
|~ ~ 7 ™
= (7] 1= B-|o-=|m- ] i 7 ¥ 9esd8

To find out what a particular button does you simply place the mouse
cursor on it and an explanation of its function appears in the prompt area
at the bottom of the HEALTHone™ Window. Wait a few seconds and its
name will appear underneath your mouse cursor.

=2 =

.-'1'-.|:tll"E lermnz |

Open

AizAnacis

1) Point your mouse at different buttons on the toolbars and observe the
prompt area at the bottom of the screen.

Note:The toolbars can be locked by default — so they can’t be
dragged into awkward positions. . To do this click on the menu item
« tools — options » and tick «Lock the toolbars».
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The Transaction and Item panels also have own toolbars:

Transaction Panel Tool Bar

Tranzactions

ﬁ Filter: Full contents

Create a
New Medical
Transaction

Adriristrative tranzaction | Billing [0.00 £] | Action plan || Appointment

/2% EE--¢ & L=
Itam %}enoe Aggregate Create a
Selector Selector Item Prescription

Selector

Item Panel Tool Bar

We have indicated the function of some of the more commonly used
buttons, however, the prompt area at the bottom of the screen will
display a description of each button when you point to it with the mouse
and they are also described on the reference sheet.

The Item, Sequence and Aggregate Selector buttons were mentioned in
the Introduction Session and this is where they are displayed on your
screen. The function of each button will be explained as they are
encountered in the book. In many instances the action of a button is also
available as an option on a menu, you can choose whatever method you
prefer to select a particular function.
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